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1. Introduction 
Automation Studio™ is a unique design, animation and simulation software tool. Originally 
created for the automation industry, it now serves OEMs operating in various types of 
industries, and fulfills engineering, training, testing, and maintenance requirements. The 
workshops associated with the software reflect as thoroughly as possible the prevailing usage 
in the industry. The software drawing, documentation, and simulation capabilities combined 
with its intuitive interface make of Automation Studio™ an efficient tool to boost 
productivity, and to improve product development, training and maintenance processes. 

In Automation Studio™ environment, users have ready access to all design tools. The core 
system contains three utilities: a Diagram Editor, a Project Explorer, and a Library Explorer. 
The Diagram Editor allows to generate and simulate diagrams, and create reports, while the 
Project Explorer handles file management, as well as the classification of all documents 
associated with a simulation project. The Library Explorer supplies the symbols libraries 
necessary for the creation of diagrams that make up your projects. 

Finally, this software allows you to document your projects. You can print and export your 
diagrams along with the various associated lists and reports required to assemble a complete 
work file. 

1.1 About Automation Studio™ 
Automation Studio™ is a simulation software package, in which various modules may be 
plugged. 

Each module, also called “workshop”, includes a component library which serves as a basis to 
create different types of circuits, such as hydraulic, pneumatic, electrical, etc. Users can create 
circuits based on a single technology or combine multiple technologies that interact with each 
other.. 

Automation Studio™ handles the editing, simulation, file and diagram management, printing 
and display functions.  

 WARNING: the simulation of a project in Automation Studio™ depends on the number 
of documents to be simulated, the number of components and the general configuration 
of your computer. A poor configuration results in a significantly slower « simulated 
time » (as shown in the status bar). 

 A 64 Mo video board helps improving the performance. 

 A scroll wheel mouse is indispensable to design efficiently.  
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1.1.1 General Information 
The Automation Studio™ user documentation has a modular structure. The current 
Automation Studio™ - User’s Guide contains information regarding the main functions of the 
Project Explorer, the Library Explorer, the common functionalities for all the Editors;  the 
Standard workshops Editor (Hydraulic, Pneumatic, Electrical Controls, Numerical, and Scale 
Diagrams), the Electrotechnical Editor and the Simulation mode. For each workshop (fluid, 
electrotechnical and SFC) and the catalog, you will find a User’s Guide providing specific 
information including a Quick Start Guide so as to help you familiarize yourself quickly with 
the different functions related to that workshop. 

Depending on the Automation Studio™ version you work with, some functions might be 
either limited (number of components, documents or projects, thermal simulation…) or 
missing (layers management, vendors’ specific components, configurators or report types…) 

However, all physics phenomena calculated by the simulator are available in all versions. 

1.1.2 Sequence of Tasks 
The sequence of tasks described in this section reflects the sequence that is normally followed 
when using the core system. Actually, changes and improvements made during the course of a 
project often require that some steps be repeated or restarted. Furthermore, this guide only 
deals with the general aspects of Automation Studio™; thus, functions specific to the 
workshops are not described in this document. 
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Figure 1–1: Tasks sequence 

1.2 Contents of the Document 
The workshops User's Guides complement this core system User's Guide. The workshop 
documents explain the theory and use of the software through exercises and examples so that 
the workshop technology is easily understood. 

Refer to the workshops User's Guide for information on the different functions, components 
and examples of applications required to learn and use Automation Studio™. 
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All the instructions required to use functions that are shared by all the workshops can be 
found in this User’s Guide. Specifically, these include the Project Explorer, the Library 
Explorer, and the Diagram Editor environments, along with their commands and dialog boxes. 
Instructions that are essential to the simulation of the different workshop technologies are also 
described. 

Instructions are presented the way the process should be executed. The content is organized so 
that each step in each section follows the next step very closely. In fact, the basic Automation 
Studio™ system can be learned by reading this guide and following the sequence of chapters 
as they are presented. For tasks specific to a workshop, users are invited to read the User’s 
Guide supplied with that specific workshop. 

You may also obtain information by consulting the index and the appendices at the end of this 
document for a summary of reference data. 

1.3 Conventions Used in this Document 
It is important to know the conventions used in this guide. They were designed to present 
information in a clear and structured way. The same conventions apply in the User's Guides 
of the different workshops. 

1.3.1 Typographical Conventions 
The following specific typographical formats are employed in this guide. 

The names of the user interface elements such as menus, commands, dialog boxes, buttons 
and fields are typed with a capital at the beginning of the word. 

Example: Choose File  Open. 

The names of the keyboard keys are shown in small capitals. 

Example: Press on the shift key to separate a component from a link. 

The names of files and directories appear in capital letters. 

Example: In the Directories list, select the C:\PROJECTS directory. 

Text, which must be entered as shown, appears in bold. 
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Example: Type setup.exe and then press the enter key to start the installation software. 

Names of variables, diagram titles and text representing information you must provide are 
indicated in italics. 

Example: In the File Name box, type the name of your file with the .PR5 extension, in the 
form name.PR5. 

Example: For more information, refer to the Windows User's Guide. 

1.3.2 Choosing Versus Selecting 
The word "choose" indicates a selection that triggers an action. 

• Example: Choose the File → Exit. 

The word select is used when identifying an object to be modified or when selecting an option 
in a dialog box. 

• Example: Select the printer driver from the Printer drop-down list box. 

1.3.3 Combinations and Sequences of Keys 
KEY1+KEY2: The plus sign (+) indicates that you must press and hold down the first key while 
pressing the second one. 

• Example: CTRL+A 

KEY1, KEY2: The comma ( , ) directs you to press on the two keys successively. 

• Example: ALT, F 

1.3.4 Basic Notions and Terminological Conventions 
There are two terminological conventions used in this document. One is for terms connected 
with the use of the mouse, and the second is for icons used in this document. 
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1.3.5 Terms Connected with the Use of the Mouse 
Term Definition 

Point to an element Position the mouse pointer on an element of the screen. 
Click Press and immediately release the mouse button. Unless 

otherwise indicated, click with the left mouse button.  
Double-click Press the mouse button twice in quick succession. Unless 

otherwise indicated, double-click with the left mouse 
button. 

Drag Press and hold the left mouse button as you move the 
mouse pointer across the screen.  

1.3.6 Notes and Tips 
The current help document uses icons to represent important notes and tips that simplify the 
commands that can be used. 

Icon Definition 

 Indicates an important notice or notion. 

 

   
Indicates a tip or a trick that simplifies the use of commands in Automation 
Studio™. 

 
Indicates that a shortcut menu is available for that specific procedure. 

 



 

 

2. Getting Started 
This chapter describes the application’s basic procedures and user interface. 

2.1 Starting Automation Studio™ 
There are different techniques of starting Automation Studio™. You may choose the starting 
option which best suits your needs. 

After Automation Studio™ has been installed, an icon appears on Windows’ desktop. 

To start Automation Studio™: 

1. Click on the Start menu at the bottom of the screen. 

2. Select the Program item. 

3. Select the Automation Studio™ item. 

4. Select the Automation Studio™ command. 

 

   Double-click on the Automation Studio™ icon on your desktop. 

The main window of Automation Studio™ opens as shown in the following figure. 
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Figure 2–1: Automation Studio™  main window 
Upon opening, Automation Studio™ window exposes a blank diagram. It also introduces the 
Diagram Editor, the Project Explorer, and the Library Explorer and their corresponding 
toolbars. 

The following chapter contains the detailed description of Automation Studio™ main 
window. In order to avoid redundancy in the information contained in the guide, functions 
appearing in the menus, toolbars and pop-up menus are only described in the menus and are 
referenced to throughout the User’s Guide. 



 

 

3. Diagram Editor 
This section introduces a detailed description of each item composing the main window of 
Automation Studio™. Items in the main window are divided into two categories: static and 
dynamic items. 

 
Figure 3–1: Diagram Editor 
A: Title bar (static); 

B: Menu bar (static); 

C: Various toolbars (static); 

D: Library Explorer (dynamic); 

E: Project Explorer (dynamic); 
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F: Pop-up menu – example (dynamic). 

3.1 Static Elements 
Static elements consist of the title bar, menu bar, and the various toolbars. You may choose to 
display and move the toolbars depending on your needs. 

3.1.1 Title Bar of the Software 
When starting Automation Studio™, the title bar of the Diagram Editor displays by default 
« Automation Studio™ – [ASProjet1 : Diagram1] ». When saving for the first time or when 
opening an existing project, the title bar displays the name of the software followed by the 
name of the project and current diagram. 

 
Figure 3–2: Title bar of the Automation Studio™ on opening 

3.1.2 Menu Bar 
The menu bar of the Diagram Editor contains nine menus. Each of these menus as well as 
their content is described in the following pages. 

 
Figure 3–3: Menu bar 

File Menu 

The File menu comprises all the menu commands related to the management of files 
(creating, opening, saving, and printing). 
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Figure 3–4: File menu 

New Project… 

This command allows the user to create a new project based on the available templates. 

Open Project… 

This command allows the user to open an existing project including those created in former 
versions back to version 3.x. 

Close Project 

This command allows the user to close a project and save, or discard the modifications that 
have been made. See section Saving a Project for the procedure. 
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New 

This command allows the user to create a new document based on the following list: 

 
Figure 3–5: New submenu 
Diagram: Create a new diagram. 

Electrotechnical: Allows the insertion of various documents necessary to create an 
electrotechnical project (non standard library). 

Sequential Function Chart: Allows the insertion and creation of a new SFC (non standard 
module) if authorized by the license. 

Report: Allows the insertion of a Bill of Material (BOM) or Report document type. 

Web Page: Allows the insertion of a link to a Web page. 

Other Document…: Allows the insertion of a document other than an Automation Studio™ 
document. This document must come from an application properly installed on the user’s 
workstation. 

Directory: Allows the creation of directories and subdirectories. 

Save as Template… 

 This command allows to save a document as a template based on the following list: 
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Figure 3–6: Save as Template submenu 
 
Project…: Allows the user to save a project template. 

Diagram…: Allows the user to save a diagram template. 

Electrotechnical Diagram…: Allows the user to save an electrotechnical template 

Sequential Function Chart …: Allows the user to save an SFC template. 

Report…: Allows the user to save a report template. 

Save Project 

This command allows the user to save a project as well as the modifications that have been 
made. See section Saving a Project for the procedure. 

Save Project as… 

This command allows the user to save, a project and its modifications under a different name 
without affecting the original version of the document. See section Saving a Project for the 
procedure. 

Import  

This command allows the user to import SFCs in GIE (Grafcet Importation / Exportation) and 
GIG (from the GRAPHITE software) formats.  
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Export… 

This command allows the user to export a diagram or SFC.  

The export is in DXF or EMF formats for diagrams (refer to the section Exporting a 
Diagram).  

SFCs are exported in GIE format or in a format recognized by certain PLCs.  The SFC export 
function is optional in the software; you must therefore posses the appropriate licence to 
access it.  

Project Properties… 

This command allows the user to enter, verify, and modify information concerning the current 
project. See section Project Properties to find out more about the tabs in the Project Properties 
dialog box. 

The user can customize its own project properties. 

Print Preview 

This command allows the user to preview the current project before printing its contents. See 
section Print Preview for the procedure. 

Print… 

This command allows the user to print part or all of the current project’s diagrams. 

Send to… 

This command allows a compressed copy of the current project to be sent via email. See 
section Sending a Project To for the procedure. 

Exit 

This command allows the user to completely close the application as opposed to the Close 
command, which only allows the user to close the project currently in use. See section Exiting 
from the Application for the procedure. 
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Edit Menu 

The Edit menu comprises all the menu commands related to the viewing and modification of 
document properties, selected items on a diagram, and the editing commands related to a 
selection on the Diagram Editor. 

 
Figure 3–7: Edit menu 

Undo 

This command allows the user to cancel the last action performed in the current document. 

Redo 

This command allows the user to reinstate the action that has been previously undone, 
performed in the current document. 

Cut 

This command allows the user to remove a selected item from the current document and store 
it in the clipboard. 

Copy 

This command allows the user to copy a selected item from the current document and store it 
in the clipboard. 
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Paste 

This command allows the user to insert an item from the clipboard into the current document. 

Duplicate 

This command allows the user to make an identical copy of a selected item from the current 
document. 

Delete 

This command allows the user to suppress a selected item from the current document, 
excepting components’ satellites. 

Select All 

This command allows the user to select every item present on the diagram and on visible 
layers. 

Component Properties… 

This command allows the user to view, enter, and modify information related to the selected 
item in the current project. 

Document Properties… 

This command allows the user to view, enter, and modify information related to the current 
document. The user can customize his/her own diagram properties. 

View Menu 

The View menu comprises all the commands related to the modification of the viewing 
properties of a diagram. 
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Figure 3–8: View menu 

Previous Zoom 

This command allows the user to revert to the last view percentage. 

Window Zoom 

This command allows the user to select an area of the diagram and set the magnification in 
proportion to the selected area. 

Zoom + 

This command allows the user to view the page from a magnification percentage of 25% up to 
a maximum of 800% independently of the selected area. 

Zoom – 

This command allows the user to view the page from a magnification percentage of 800% 
down to a minimum of 25% independently of the selected area. 
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Zoom All Components 

This command allows the user to view the complete set of components on the page 
independently of their position on the diagram. 

Page Zoom 

This command allows the user to view the entire page in its height. 

Panning 

This command allows the user to translate the page in real time and its content in a 
multidirectional movement. 

Grid 

This command allows the user to display the grid used to snap symbols into place. 

Rulers 

This command allows the user to display or not, the vertical and horizontal rulers. 

Contact Points 

This command allows the user to view the contact points of each symbol on the diagram. 

Connection Ports 

This command allows the user to view the connection ports of each symbol on the diagram. 

Connection Port Names 

This command allows the user to view the name of all the connection ports of each symbol on 
the diagram. 
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Hyperlink 

 This command allows the user to display assigned tagnames with an hyperlink format or as a 
normal text. 

Component Snap 

This command, when selected, ensures that symbols from the libraries snap to the grid on the 
diagram. 

Grid Properties 

This command allows the user to modify the drawing elements’ snap properties as well as the 
colour of the grid. 

Line’s Jump Setting 

This command allows the user to choose the representation on the diagram of two lines which 
cross or are connected in a point. 

 The dynamic zoom, which is more user-friendly than clicking on buttons, is accessible 
when maintaining down the CTRL key and by using the mouse scroll wheel.  

Insert Menu 

The Insert menu comprises the commands related to adding drawing elements and text fields 
in a diagram. This menu is only visible when a diagram is active. 
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Figure 3–9: Insert menu 

Line 

This command allows the user to draw lines on a diagram. 

Rectangle 

This command allows the user to draw rectangles on a diagram. 

Arc 

This command allows the user to draw arcs on a diagram. 

Ellipse 

This command allows the user to draw ellipses of various sizes on a diagram. 

Polygon 

This command allows the user to draw polygons of various sizes on a diagram. 

Text 

This command allows the user to insert text areas in a diagram. 
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Picture… 

This command allows the user to insert a JPG and BMP format image in a diagram. 

Field… 

This command allows the user to insert automatic fields containing the current diagram or 
project properties. 

Bill of Materials 

This command allows the user to automatically insert, in a diagram, bill of materials 
containing by default the Quantity and Name of Component properties. The bill of material 
can be configured. 

Historique des révisions 

 This command allows the user to insert in a diagram a table that resumes the historic of the 
revisions. The way of work this table is the same as a Bill of Materials. 

Link 

This command allows the user to insert a link in a diagram. 

Direct Link 

 This command allows the user to insert a direct link in a diagram. 

Layout Menu 

The Layout menu comprises all the commands related to the modification of the orientation 
and layout of elements in a diagram. This menu is visible only when a diagram is active. 

In this case, an object can be a symbol, a group, or a multiple selection of these elements. If 
the selection is a group, the layout functions apply on the axis of symmetry and on the centre 
of rotation of the group. If it is a multiple selection, the layout functions apply individually on 
each element of the selection. 
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Figure 3–10: Layout menu 

Rotate 180° 

This command allows the user to apply a rotation of 180 degrees to a selected object. 

Rotate Left 

This command allows the user to apply a counter clockwise rotation of 90 degrees to a 
selected object. 

Rotate Right 

This command allows the user to apply a clockwise rotation of 90 degrees to a selected object. 

Vertical Flip 

This command allows the user to transpose a selected object on its vertical axis. 
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Horizontal Flip 

This command allows the user to transpose a selected object on its horizontal axis. 

Layout 

This command opens the dialog, which allows alignment, distribution, scaling, and 
transformations. When multiple items are selected, the handles of the first item (the master) 
are blue whereas the ones of the other items (the slaves) are white. Most of the following 
manipulations apply to slaves relatively to the master or entire page. 
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Alignment 

 
Figure 3–11: « Alignment » tab 
Vertical left Allows the alignment of all selected items on a vertical axis, 

relatively to the left part of the master.  

Vertical center Allows the alignment of all selected items on a vertical axis, 
relatively to the center of the master 

Vertical right Allows the alignment if all selected items on a vertical axis, 
relatively to the right part of the master.   

Horizontal up Allows the alignment of all selected items on the horizontal axis, 
relatively to the upper part of the master. 
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Horizontal center Allows the alignment of all selected items on a horizontal axis 
relatively to the center of the master.  

Horizontal down Allows the alignment of all selected items on a horizontal axis 
relatively to the right part of the master. 

Component When this option is selected, the master becomes part of the 
diagram.  

Page When this option is selected, the master becomes the entire page.  

Distribution 

 
Figure 3–12:  « Distribution » tab 
 



  Project example 

3-18 
 

 

 

Horizontal  Allows to distribute evenly all vertical axis of symmetry of each of 
the selected items. 

Vertical  Allows to distribute evenly all horizontal axis of symmetry of each 
of the selected items.  

Component When this option is selected, the distribution is based on the items 
of the diagram.  

Page When this options is selected, the distribution is based on the 
entire page.  

Dimensions 

 
Figure 3–13:  « Distribution » tab 
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Horizontal  Allows to stretch horizontally all selected items until they reach 
the master’s dimensions.   

Vertical  Allows to stretch vertically all selected items until they reach the 
master’s dimensions. 

Horizontal and 
vertical 

Allows to stretch vertically and horizontally all selected items until 
they reach the master’s dimensions. 

Transformation 

Any selected item inserted onto a diagram is circled with a rectangle and handles (blue or 
white). The coordinates of the upper left corner of this rectangle, also called selection box, 
can be located thanks to the X and Y values measured relatively to the upper left corner of the 
document.   
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Figure 3–14 :  « Transformation» tab 
 
X The abscissa (coordinate  X) of the upper left corner of the 

selection box prior to any rotation or flip operation.  

Y The ordinate (coordinate Y) of the upper left corner of the 
selection box prior to any transformation. . 

W Width of the selection box prior to any rotation or flip operation. 

 H Height of the selection box prior to any rotation or flip operation. 

 A Angle of the selection box with the horizontal flip axis.  

Horizontal flip This button gives the state of the selected item. When you click on 
this button, the item is flipped horizontally.  
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Vertical flip This button gives the state of the selected item. When you click on 
this button, the item is flipped vertically.   

Image This image gives a visual explanation.  

Bring to Front 

 Inserted symbols are laid on overlapping layers. The first layer can be seen above all the 
others and the last layer is below all the others. 

This command allows the user to bring a selected object onto the first layer of the elements on 
the diagram. 

Send to Back 

This command allows the user to bring a selected object onto the last layer of the elements on 
the diagram. 

Bring Forward 

This command allows the user to bring a selected object one layer above the current one. 

Send Backward 

This command allows the user to bring a selected object one layer below the current one. 

Group 

This command allows the user to bring together selected objects into one element called a 
group. 

Ungroup 

This command allows the user to break up a selected element into individual objects. 

 A link is a line connecting two or more symbols to be simulated. 
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Direct Link 

This command allows to avoid all detours within a link. In other words, this command applies 
the rule of the “shortest distance between two points”. 

Break Link 

This command allows the user to divide a link into two or more segments. 

Join Links 

This command allows the user to unite two distinct links into one. 

Convert Link to Jumps 

In the standard modules, this command allows the user to transform a link between two 
components into two jumps. These jumps have an identical mnemonic in order to reduce the 
number of links within a circuit. 

 Jumps may be inserted from the library in order to keep the circuits that are spread out on 
several diagrams linked together. 

Simulation Menu 

The Simulation menu comprises the commands related to the simulation of a project or a 
diagram. 

The simulation of a project or diagram launches the simulation engine that computes and 
solves the selected portion of the drawn circuit, and responds to the behaviour and animation 
of symbols. 
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Figure 3–15: Simulation menu 

Normal 

This command allows the user to simulate a circuit in normal mode. This mode corresponds 
to the maximum speed of the simulation evaluation based on the installation. 

Step by Step 

This command allows the user to simulate a circuit in the Step by Step mode. 

Slow Motion 

This command allows the user to simulate a circuit in a slow motion mode. 

Pause 

This command allows the user to temporarily stop the simulation of a circuit and to resume it 
later on. 

Stop 

This command allows the user to permanently stop a simulation and to return to the editing 
mode. 
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Project 

This command allows the user to simulate the set of diagrams included in the current project. 

Document 

This command allows the user to simulate the current diagram. 

Selection 

This command allows the user to simulate selected diagrams with the Simulated Items 
command. 

Select Items to Simulate 

This command allows the user to select diagrams from the current project for their 
simultaneous simulation. 

Tools Menu 

The Tools menu comprises commands related to the configuration of the software and fields, 
and to the verification of a diagram. 

 
Figure 3–16: Tools menu 

Verify Connections … 

This command allows the user to verify all the connections on every component in the active 
diagram. 
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Field Configuration… 

This command allows the user to customize components property fields. 

Catalog 

This menu allows the user to access the catalog manager.   

Options… 

This command allows the user to adjust the application and its modules based on his 
preferences. 

Window Menu 

1. Windows Organization 

Automation Studio™ allows you to organize the display of projects and their diagrams in 
different windows. You can easily optimize the display of these windows while designing and 
simulating your project. 

2. Benefits from Multiwindowing 

The capability of Windows to display simultaneously multiple windows facilitates the 
exchange of information between the different open windows on your screen. In Automation 
Studio™, this capability is a highly useful analysis tool for the following applications: 

• To evaluate one or more diagrams during simulation; 

• To highlight sections of the diagram which behaviour under simulation is of particular 
interest. 

This feature is useful when working on complex circuits contained on large-size diagrams or 
during the simulation of a project containing many diagrams. The following figure is an 
example of how a multiwindow display enables to view two different windows at the same 
time. 
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Figure 3–17: Simulation and Multiwindowing 

3. Window Layout 

From the Window menu, you can organize the layout of open windows during your work 
session. The following is a description of the different commands in this menu. See the 
Windows User's Guide for more information on the organization of windows. 

The Window menu comprises the commands related to the organization of the windows 
layout and the duplication of specific windows. 



  Project example 

3-27 
 

 

 

 
Figure 3–18: Window menu 

New Window 

This command allows the user to open a new window that shows a different view of the 
current diagram. 

Close All Windows 

This command allows the user to close all the windows of the current project. 

Display 

This command allows the user to display the various utility programs for managing 
Automation Studio™, as well as the toolbars the user may require to work. 
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Figure 3–19: Display submenu 
Toolbars…: this command allows the user to select the toolbars to be displayed on the screen. 
See section Toolbars to find out more about all the toolbars. 

Photo: this command allows the user to display or hide the photo window, if available. 

Layers: this command allows the user to display or hide the layers window. 

Messages: this command allows the user to display the message window. 

Project Explorer:  this command allows the user to display the Project Explorer. 

Library Explorer:  this command allows the user to display the Library Explorer. 

Plotter:  this command allows the user to display the Plotter for standard Editor. 

Eectrotechnical Plotter :  this command allows the user to display the Electrotechnical Plotter. 

Status Bar:  this command allows the user to display the Status Bar. 

Variables Explorer:  this command allows the user to display the Variables Explorer. 
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Localisation : this command allows the user to open the size and dimension dialog box for the 
Panel Layout Workshop. 

Horizontal Tile 

This command allows the user to display the various projects’ windows horizontally, whether 
they are active or not. 

Vertical Tile 

This command allows the user to display the various projects’ windows vertically, whether 
they are active or not. 

Cascade 

 This command allows the user to display the various projects’ windows, whether they are 
active or not, one after the other with a slight gap between them. 

Open Project or Diagram Window 

This command allows the user to select the project’s window to be displayed on top. 

Help Menu 

The Help menu comprises the commands related to the contextual help. 
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Figure 3–20: Help menu 

Context Help 

This command opens the contextual help of the current window (Project, Library Explorer, 
etc.); or of the current element (component, group, DAO, etc.). 

Help Content 

This command opens the Table of Contents of Automation Studio™ User’s Guide. 

Software Registration 

This command allows the user to register his/her copy of Automation Studio™ with Famic 
Technologies Inc. through the Internet. 

 Your workstation must be connected to the Internet to access this service. 

 You must register your copy of Automation Studio™ to access the online support. 

Online Support 

This command allows the user to access the various Web services available for Automation 
Studio™. 
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Figure 3–21: Online Support submenu 
Client Support Page: this command allows the user to gain access to his/her personal technical 
support portal. 

 Your version must be registered upon installation or by mail/fax or through the Software 
Registration command from the Help menu. 

Discussion Forum: this command allows the user to gain access to our online discussion 
forum regarding Automation Studio™. 

Frequently Asked Questions:  this command gives access to the list of frequently asked 
questions. These questions were asked by Automation Studio™ users who encountered 
similar problems, and whom the Technical Support team gave answers to. In order to help 
other and future users, and to facilitate the access to this information, we have decided to 
gather those FAQ and to release them.   

Automation Studio™ on the Web: this command allows the user to directly access the 
software’s newest features. 

Suggestions: this command allows the user to access a virtual suggestion box, which users 
may send suggestions to via email. 

About… 

This command allows the user to view the information such as modules, system, 
identification, etc., which pertains to the installation of the software. 

3.1.3 Toolbars 
 In order to display or hide a toolbar, choose Window → Display → Toolbars, then check 

or uncheck the toolbar. This command is also available through the F6 key or through a 
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shortcut menu when the pointer is placed on top of any toolbar. To move a toolbar, click 
on the toolbar without releasing the mouse button, then move the mouse to the place the 
toolbar is to be released. 

Project Toolbar 

The Project toolbar contains buttons that correspond to commands of the Project Explorer and 
Diagram Editor that are most often used. The toolbar automatically adjusts itself to the 
functioning utility. When the command is unavailable in the utility, the button is greyed out 
and is no longer inaccessible. 

 
Figure 3–22: Project toolbar 
The toolbar contains the following commands. 
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Command Description 

A - New Project Creates a new project. 

B - Open Opens an existing project. 

C - Save Saves the current project. 

D - Print Launches the print sequence. 

E - New Diagram Creates a new diagram (standard). 

F - New 
Electrotechnical 
Diagram 

Creates a new electrotechnical diagram. This is a non-standard 
module that can only be used with the appropriate license. 

G - New Report Creates a new bill of material (BOM - or report type of documents. 

H - New SFC Creates a new SFC. This is a non-standard module that can only be 
used with the appropriate license 

I - Project Explorer Opens or closes the Project Explorer window. 

J - Library 
Explorer 

Opens or closes the Library Explorer window. 

K - Variable 
Explorer 

Opens or closes the Variable Explorer window. 

L - Pictures Opens or closes the Photo window. 

M - Back Allows the user to navigate between hyperlinks. 

Edit Toolbar 

The Edit toolbar of the Diagram Editor appears by default only when a diagram is active. 
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Figure 3–23: Edit toolbar 
The toolbar contains the following commands. 

Command Description 

A - Cut Removes the selected object and stores it in the Clipboard. 

B - Copy Copies the selected object and stores it in the Clipboard. 

C - Paste Adds the content of the Clipboard onto the diagram. 

D - Undo Cancels the last executed action. 

E - Redo Reinstates the last cancelled command. 

F - Properties Displays the component’s Properties dialog box that introduces the 
selected item’s properties. 

Simulation Toolbar 

The Simulation toolbar of the Diagram Editor contains the following buttons. 
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Figure 3–24: Simulation toolbar 
Command Description 

A - Normal Simulates a circuit in normal speed. 

B - Step by Step Simulates a circuit step by step. Each mouse click corresponds to 
one cycle. 

C - Slow Motion Simulates a circuit at the slowest speed. 

D - Pause Interrupts simulation. 

E - Stop Stops simulation. 

F - Project 
Simulation 

Selects all the current project’s diagrams when launching 
simulation. 

G - Document 
Simulation 

Selects the current diagram when launching simulation. 

H - Selection 
Simulation 

Selects the selected items when launching simulation. 

I - Select Items to 
Simulate 

Opens the dialog box of diagrams to be simulated in the current 
project. 

J - Plotter Opens or closes the Plotter window. 

K - Electrotechnical 
Plotter 

 Opens or closes the Electrotechnical Plotter window. 
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View Toolbar 

The View toolbar of the Diagram Editor contains the following buttons. 

 
Figure 3–25: View toolbar 
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Command Description 

A - Zoom % Drop-down list allowing the selection of a predefined percentage of 
image magnification on the screen. 

B - Zoom + Increases the image magnification of the diagram (maximum 
enlargement percentage of 800%).  

C - Zoom - Reduces the image magnification of the diagram (minimum 
reduction percentage of 25%). 

D - Window Zoom Allows the user to frame an area and enlarge it to display its 
magnification in proportion to the selected area.  

E - Page Zoom Displays the whole diagram on the screen.  

F - Zoom all 
Components 

Displays all items contained in the workspace.  

G - Zoom Page 
Width 

Displays the page width wise.  

H - Panning Moves into the panning mode.  

I - Component 
Snap 

Enables or disables the component snap onto the grid  

J - Connexion ports Display or hide the Connexion ports.  

K - Connexion Port 
Names 

Display or hide the Connexion Ports.Name  

L - Contact Points Display or hide the Contact Points  

M - Hyperlinks Display tagname as hyperlinks or normal text  

N - Grid Display or hide the Grid.  
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Command Description 

O - Grid Properties Opens the dialog properties of the grid. 

Insert Toolbar 

The Insert toolbar of the Diagram Editor contains the following buttons. 
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Figure 3–26: Insert toolbar 
Command Description 

A - Selection Allows the selection of an item in the workspace. 

B - Line Draws a line.  

C - Rectangle Draws a rectangle.  

D - Ellipse Draws an ellipse.  

E - Arc Draws an arc.  

F - Polygon Draws a polygon.  

G - Text Inserts a text box.  

H - Image Inserts an image.  

I - Field Inserts a field.  

Layout Toolbar 

The Layout toolbar of the Diagram Editor contains the following buttons. 
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Figure 3–27: Layout toolbar 
Command Description 

A - Rotate Left 
90° 

Pivots the selection 90° counter clockwise.  

B - Rotate Right 
90° 

Pivots the selection 90° clockwise.  

C - Free Rotation Allows the user to pivot the selection freely using the handles.  

D - Vertical Flip Inverts the selection on its vertical axis.  

E - Horizontal 
Flip 

Inverts the selection on its horizontal axis.  

F - Bring to Front Brings the selection to the first layer of the diagram.  

G - Send to Back Sends the selection to the back layer of the diagram.  

H - Group Groups all the selected elements.  

I - Ungroup Ungroup the selected group.  

J - Layout Allows to change symbols’ alignment and layout 

Links Toolbar 

La barre d'outils « Liens » de l'Éditeur de schémas contient les boutons suivants. 
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Figure 3–28 : Barre d’outils Format 
Command Description 

A - Links Creates technological links.  

B - Direct Link Removes all deviations in a link. 

C - Line ‘s Jump 
Setting 

Removes all deviations in a link. 

D - Link to Direct 
Link 

Convert Link to Direct Link and the reverse. 

E - Break Link Divides a link into two or more segments.  

F - Join Links Connects two distinct segments linked by a connection into a 
single link.  

G - Convert Link to 
Jumps 

Transforms a link into two jumps with the same mnemonic.  

Format Toolbar 

 The Format toolbar of the Diagram Editor contains the following buttons. 
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Figure 3–29: Format toolbar 
 
Command Description 

A - Colour Modifies the line colour of the selected graphic object, as well as 
the font colour of typed text on the diagram only. 

B - Thickness Modifies the thickness of the line of the selected graphic object on 
the diagram only.  

C - Line style Modifies the graphical lines’ style. 

D - Visible Makes the selected components visible or invisible. 

3.1.4 Status Bar 
The status bar displays the description of menus and commands for each utility when selected 
by the user. It also contains different information slots displaying the current mode 
(Simulation or Editing) or the status of specific keys (MAJ, NUM, DEF, INS). Furthermore, in the 
Diagram Editor, it informs the user on the pointer’s position on the diagram.  

The following information is displayed on the right-hand side of the Status bar. 

 
Figure 3–30: Status bar 
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Slot Function 

ST 
XX :XX :XX.XX 

Elapsed time since simulation started. 

X=XXX,Y=YYY Indicates the pointer’s coordinates in the diagram. 

X % Indicates the zoom factor currently used in the diagram. 

3.1.5 Plotter 
The Plotter allows the user to watch the evolution in time of various variables in a graphic 
window during simulation. Several variables of different components can be viewed 
simultaneously in a single graph. 

Description of the Plotter 

The displayed values are established by default by the software. Some of them are modifiable 
while others remain static. The following list provides a short description of the data available 
in the Plotter and in its table of variables. 
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Figure 3–31: Plotter 

 Each project has its own standard plotter.and its own Electrotechnical Plotter 
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Zone Description 

Scale Displays the Y-axis (ordinates) of each selected variable.  

Graph Plotting area of the evolution curves.  

Properties list Modifiable display of the variable properties list. 

Component Displays the internal identifier in the list. This value is static. 

Name Displays the name of the component. This value is static. 

Variable (Plot) Displays the name of the variable. This value is static. 

Colour Displays the colours, defined by default, and which identify the 
variable and its curve. This colour is modifiable. 

Min. Scale Displays the minimal traceable value of the associated variable. A 
value is assigned to each variable by default. This value is 
modifiable 

Max. Scale  Displays the maximal traceable value of the associated variable. A 
value is assigned to each variable by default. This value is 
modifiable 

Current unit Displays the component’s measure unit value. This value is static. 

Interval-Time Displays the value of the time interval visible on the graph for all 
traced variables. This value appears in seconds and can be 
modified. 

Export Exports the curves in a tabulated .txt format. 

Help Displays the help text of this dialog box. 

Properties Gives access to the list of variables modifiable and of static 
properties. 
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Zone Description 

Apply Executes a modification or a deletion, and applies it to the graph 
and scale. Click on this button after each modification or after all 
modifications have been entered. 

Delete Removes a selected variable in the list. 

Cancel Allows the user to invalidate a modification or deletion that has 
previously been executed. 

3.1.6 Display of Photos 
There are photos for various hydraulic, pneumatic and electrotechnical components from the 
main library. The photo window displays these photos both in edit and simulation mode. 

 To display this window, go to the menu “Window”  “Display”  “Photo” or use the 
“F4” key. 
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Photo window description 

 
Figure 3–32 : Photo window 
 
Zone Description 

A - Title (Number of the displayed photo / Number of photos ) Name of 
component  

B - Visualisation by 
click 

When this button is active, simply left-click with the mouse on the 
desired component to view its photo. As long as the component 
remains selected, and provided that a photo is linked to it, the 
photo window remains open.  
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Zone Description 

C - Visualisation by 
hovering 

When this button is active, simply place the mouse pointer over 
the desired component to visualise its photo. If no photo is linked 
to the component, the window disappears after a while. 

D - Previous Allows to visualise the previous photo, provided that it exists. 

E - Next Allows to visualise the next photo if it exists. 

F - Display Photo display zone. If a photo does not exist then this window 
automatically disappear after a while 

3.1.7 Message Window 
This window automatically opens to inform the user of any detected errors that require 
correction. 

3.2 Management Utilities 
The management utilities are used to manage projects. Each of these utilities offers the 
possibility to manage projects based on users’ requirements, whether to manage variables or 
to create component libraries. 

To display or hide the management utilities: 

Select the Window menu  Display  select the    

Automation Studio™ opens the list of utilities to be displayed or hidden. When the name of a 
utility is preceded by a checkmark, it means that it is actually being displayed on the screen. 
Figure 3–19: Display submenu shows all utilities available in Automation Studio™. Each of 
these utilities is described in the following pages. 

 In order to optimize the workspace, every utility window is supplied with a 
“Thumbtack”. When in this position , the “thumbtack” allows windows to 
automatically roll up. Once rolled up, windows only show their title bar unless the mouse 
pointer is placed upon the window title bar.. To prevent windows from automatically 
rolling up on themselves, the “thumbtack” button must be in this position . 
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3.2.1 Library Explorer 
The Library Explorer contains the symbols libraries which include thousands of symbols for 
hydraulic, pneumatic, control command components, etc. The Library Explorer provides all 
necessary elements to build a functional circuit. It also allows the user to create and manage 
new libraries and new components according to his/her requirements. 
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Figure 3–33: Library Explorer window 
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The elements composing the Library Explorer are the following: 

Command Description 

A - Toolbar Allows to manage, select, and create libraries and components. 
The Library Explorer toolbar is described in detail in the following 
pages. . 

B - Tab(s) Allows to select the library complying with your diagram’s 
requirements in order to facilitate the creation of circuits. The 
Main Library tab corresponds to the standard library of 
Automation Studio™.  

C - Library window Allows to display the tree, to select subgroups, as well as 
specialized workshop families such as hydraulics, pneumatics, etc. 
Each type of library contains corresponding components.  

D Component 
window 

Allows to display and select the components necessary to build a 
circuit.  

Library Explorer Toolbar 

The Library Explorer toolbar of the Diagram Editor consists of the following buttons. 
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Figure 3–34: Library Explorer toolbar 
Command Description 

A - Open library Opens one of the libraries available, either the standard or 
customized libraries. 

B - Create library Creates a library that can be customized based on the project 
requirements.  

C - Save library Saves the libraries that have been customized based on the project 
requirements.. 

D - Create category Creates a category of components that can be customized based on 
the project requirements.  

E - Delete category Deletes a category of components. Only categories created by the 
user can be deleted; categories supplied with Automation Studio™ 
cannot.  

F - Lock/Unlock Locks/unlocks a library thanks to a password so as to protect it 
from being deleted by mistake.  

3.2.2 Project Explorer 
The Project Explorer controls all functions related to the management of opened projects and 
their documents. Thanks to shortcut menus related to the selected document, the Project 
Explorer makes it possible to create, display, save, export/import, send to, and simulate a 
document as well as to print it in parts or in whole. 
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Figure 3–35: Project Explorer window 
Command Description 

Tree window Allows the user to select elements from a project’s tree, and to 
implement an action on the selected element (print, copy, rename, 
etc.).  

 

   To take full advantage of the software, it is strongly suggested that projects or files 
are managed through the File menu of the main window, and documents through the shortcut 
menus of the Project Explorer. 

3.2.3 Variable Manager 
The Variable Manager offers the user the ability to filter, modify, view, and link to OPC items 
all the variables contained in the active project. It also allows to create and delete internal 
variables. 
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Figure 3–36: Variable Manager window 
Command Description 

Filter Sorts out variables based on a specific character chain. Variables 
with a mnemonic containing the character chain defined as filter 
are sorted out to be displayed. 

Update In editing mode, refreshes the variable list after having added or 
deleted internal variables or components. 

In simulation mode, it allows to update the variable’s value. 

New Variable Creates a new internal variable. See Adding a Variable 

Modify Variable Modifies one of the variable properties. See Modifying a Variable 

Delete Variable Deletes an internal variable. Does not allow the user to suppress a 
component’s variable. 

To delete a components variable, the component itself has to be 
removed from the diagram. 

OPC Links  Opens the dialog box used to create read/write links to OPC items. 
See Creating an External Link. 

Variable List Displays the project’s variables based on the current filter. 
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Command Description 

Help Opens the contextual help. 

Close Shuts the Variable Manager’s window. 

Adding a Variable 

To create an internal variable: 

1. Click on the New Variable button (in the Variable Manager window or in the Ladder of 
SFC Component Properties dialog box). 

The OPC Settings dialog box opens. 

2. Fill in the various fields. 

3. Click OK. 

 You can only create internal variables. Component variables are automatically created 
when components are created. 

 The tag name of the variable must not contain spaces and must start with a letter or a 
number. It must include at least one letter. It must be unique in the project or document 
based on the global or local link of the variable. Reserved names must not be used (ABS, 
SQR, etc.). 

 The address must comply with the manufacturer’s syntax and be unique in the project. 
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Figure 3–37: Add a Variable dialog box  
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The following is a description of the fields composing this dialog box. 

Field Description 

Tag Name Displays the variable’s tag name and allows it to be modified if 
the field is not greyed out. 

Address Allows to type in the variable’s address when it is a PLC 
variable. 

Variable Type This drop-down list allows the selection of one of the following 
types of variable: 

Generic Boolean; 

Integer (32 bits); 

Float (32 bits). 

Document This drop-down list allows to specify whether the variable is 
global for the current project or local for a document: 

Project (global); 

Diagram name (locale for a diagram or SFC). 

Description Allows the user to type in a comment related to the variable. 

Modifying a Variable 

To modify the name, initial value, address, or description of a selected variable: 

Select the variable you wish to modify and click the Modify Variable button or double-click 
on the line containing the variable. 

The Modify Variable dialog box opens. 
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Modify the required fields. 

Click on OK. 

The Modify Variable dialog box closes. 

The new properties are saved and updated. 

All diagrams, in which the modified variable appears, are also updated with the new 
properties. 

 Only variables of transmitter, transmitter/receiver components may be modified. Fields 
are grayed out for variables of receiver components. 

 Variables’ tag name must start with a letter or a number and must not contain a space. 
The name must contain at least one letter. The variable’s tag name must be unique in the 
project or document depending on the link (global or local) of the variable. Reserved 
names must not be used (ABS, SQR, etc.). 

 The address must comply with the manufacturer’s syntax and be unique in the project. 

 It is possible to modify the link (affiliation document) of a variable. 



  Project example 

3-59 
 

 

 

 
Figure 3–38: Modify Variable dialog box 
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Here is a description of the available fields in the Modify Variable dialog box: 

Field Description 

Tag Name Displays the variable’s tag name and allows it to be modified if 
the field is not greyed out. 

Value Allows to type in an initial value for the variable. 

Hexadecimal/Binary Allows to convert whole numbers into hexadecimal and binary 
numbers. 

Address Allows to type in the variable’s address when it is a PLC 
variable. 

Description Displays comments related to the variable. 

Sorting Variables 

To sort variables: 

Click on a column header in the table. The variables in that column are alphabetically sorted. 

Click on the header of the same column a second time and the order of the variables is 
reversed. 

Filtering Variables 

To filter variables: 

Type in a character string. This string must begin by either a letter or a number. It must also 
contain at least two characters, one of which must be a letter. It must not contain any spaces. 

Only variables containing this character string are displayed in the table. 
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Supervising Variables’ Values in Simulation Mode 

You may find yourself in a situation in which a circuit is not behaving the way it’s intended 
to. To solve this problem, and if simulation has not helped yet, you can rely on the Variable 
Manager to inform you on the state or value of variables. You can then identify the 
components and variables that do not behave properly.  

To view the variables’ values: 

Start simulation. 

Filter and sort variables if necessary. 

Adjust the size of the Variable Manager window if necessary. 

Click on the Update button to refresh the variables’ values. 

 Only variables that can act as a transmitter, transmitter/receiver, or receiver can be 
viewed in the Variable Manager. For other variables (pressure, flow, etc.), refer to 
Plotter. 

3.2.4 Layer Manager 
The layer manager allows the creation of various layers in standard and electrotechnical 
editing diagrams (not available for SFC). 
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Figure 3–39: Layer Manager window 
 
Zone Description 

Name Column Gives a name to the layer.  Each layer’s name must be unique.  

Visibility Column Makes the selected layer visible or invisible. If a layer is invisible 
it cannot be printed, nor can it be exported. 

Locked Column Allows the user to lock or unlock the selected layer. If a layer is 
locked the user will not be able to modify its elements. 

Description Column Allows the user to describe the selected layer.  

New Layer Creates a new layer. 

Delete Layer Deletes a layer and all elements that belong to it.  

Select Components Allows the user to select all the components of the active layer.  

Layer activation 

There are two methods to activate a layer: 
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• Left-click with your mouse on the desired layer in the layer manager window, then click 
on an empty zone of the diagram. 

Or 

• Select a component that is part of the desired layer. 

Positioning of an element on a layer 

If the element comes from the library or from another diagram, then activate the desired layer 
and insert the element into the diagram. 

If the element is already on the diagram, there are two solutions: 

• Cut the component (CTRL + X), select the desired layer in the layer manager, click on an 
empty zone in the diagram and paste the component. 

Or 

• Open the component properties dialog (component or group) and go to the displayed 
information.  Modify with the drop-down menu the “layer” property. 

 If you group components that belong to different layers, the group and its components 
then belong to the active layer. If you ungroup them, each component returns to its initial 
layer. 

 Satellites (displayable property of a component) belong to the same layer as its 
corresponding component. 

3.3 Shortcut Menus 
The Diagram Editor’s shortcut menus have been created in order to facilitate access to tool 
and menu bars. With the exception of a few commands specifically created for specific cases, 
all commands found in the shortcut menus are either in the tools or the menu bars. 
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3.3.1 Open a shortcut Menu 
Shortcut menus are displayed when right-clicking on an element within the Diagram Editor. 
The shortcut menu of this element opens on the screen, and the user may then choose the 
available command from this menu. 

3.3.2 Specific Commands of Shortcut Menus  
Some commands are only available through shortcut menus. They are neither accessible 
through standard menus, nor through button bars. These commands specifically apply to the 
selected item or to the current context. Refer to other guides to discover specific context 
menu. 

Symbol in Simulation 

Animation 

This command applies to the components in the Diagram Editor while in Simulation mode. It 
allows the user to open the window in order to see the synchronized cross-section view of the 
component. 

Setting 

Clicking on some components during simulation allows the user to modify the functional 
adjustment setting (e.g.: valve opening pressure) applied to components or to control the 
position or state (distributors, shut-off  

Symbol Area in the Library Explorer 

Small/Medium/large Icons 

This command applies to components in the Library Explorer. It allows the user to determine 
the display size of the components within the symbols library window. 

Rename 

This command applies to new components, libraries, and categories in the Library Explorer 
and to projects and diagrams in the Project Explorer. It allows to give the selected element  a 
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different name than the one automatically assigned by the software. Therefore, the user can 
rename documents and work tools in concordance with his/her specific needs. 

 



  Project example 

66 
 

 

 

4. Creation and Management of a Project and its 
Documents 

This chapter describes the instructions required for to create and manage projects within the Project Explorer. 

This chapter covers the following topics: 

• Management of projects (files created by Automation Studio™) and of their documents; 

• Management of documents from a project. 

4.1 Creation of a New Project 
To create a new project: 

Choose File  New Project. 
 

The Project Templates dialog box opens and offers a selection of templates to choose from, and which the user 
can base his new project on. 

 
Figure 4–1: Project Templates dialog box 
Choose the desired template or choose “None” if none of the available templates correspond to your needs. 

Then, click on “OK” to create the new project. 

A new project identical to the selected model opens on the screen as well as in the Project Explorer. By default, a 
name is assigned to the project; this name may be modified. By default, the software includes a blank diagram 
within the new project. 

You may now include documents of your choice in the new project. (For more details on how to manage 
diagrams, refer to the section Creating a New Document.) 

4.1.1 Saving a New Project 
When a project is created, by default it is labelled with a sequential name. To save the new project, follow these 
steps: 

Select File  Save Project as. 

The Save As dialog box appears on the screen. 
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Figure 4–2: Save as dialog box 
 
Type in the name of the file in the File name field. 

Select the appropriate directory from the Save in drop-down list. 

Click on Save. 

If the option “Always Prompt Summary Info at the First Save” is checked in the Application branch of the 
Options available from the Tools menu, then, the Project Properties dialog box opens on the screen, and displays 
the Summary Info branch. The information from the Project Properties dialog box may be modified at any time. 
You may fill it out now and modify it later. 

To complete the procedure for saving a new project: 

Click on OK. 

The new document has been created and is ready to receive all the elements and modifications you wish to 
include. 

If you want to save a project for the Automatin Studio™ Runtime Application, you have to choose the extension 
ASR instead of PR5. 

4.1.2 Opening a Project 
To open a project: 

Choose File  Open Project...  

The Open Project… dialog box appears on the screen. 
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Figure 4–3: OpenProject… dialog box 
From the Drives and Directory lists, select the disk and directory containing the project. 

Then, select the file you want to open so that it appears in the File name field. 

Click on the Open button. 

4.1.3 Closing a Project 
To close a project: 

Choose File  Close Project. 
 

If no modification has been made since the project was last saved, the software just closes the current project. 

If modifications have been made since the last time the project was saved, a message appears on the screen 
requiring confirmation to save the latest modifications. 

If you wish to save the modifications, click on the “Yes” button. 

If the project has already been saved under a specific name, a new save is automatically executed. 

Had the project never been saved, the “Save As” dialog box automatically opens. See section Saving a New 
Project for the procedure. 

If you do not wish to save the last modifications, click on “No”. 

The software closes the project. The most recent modifications are lost. 

The Project Explorer no longer contains that project. 
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4.2 Creating a New Document 
It is possible to include different types of documents within a project. These different types include diagrams 
integrating components from standard workshops, documents integrating components from non-standard 
workshops, reports, and documents coming from external applications such as Web pages, Word-processing 
documents, spreadsheets, etc. 

4.2.1 Creating a New Diagram 
To create a new diagram: 

Choose File  New  Diagram. 
  

The Diagram Templates dialog box opens on the screen. 

 
Figure 4–4: Diagram Templates dialog box 
Select the template corresponding to your requirements. If none of the templates suits you, select the "None" 
template and modify it according to your needs. 

Click on OK. 

 You may create a new diagram compliant with your needs and standards, and save it as a template. See 
section 
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Saving a Template for the procedure. 

 A diagram template may contain drawn elements, a header, components, and images. Refer to the section 
Inserting a Graphic Element_Menu_Insertion for inserting fields, graphic elements, and images in a 
diagram. 
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5. Project example 
 

Open new project. Display of the initial  screen afer project opening is shown in picture 5.1. 

 

Picture 5.1. Initial screen after opening of new project 

From pneumatic library place elements as shown in the picture 5.2. 

 

Picture 5.2 . Basic  pneumatic circuit build using pneumatic library. 
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After finishing of the circuit run the simulation. Screen should look like in the picture 5.3. 

 

Picture 5.3. Simulated pneumatic circuit. 

If the simulation runs well, modify scheme adding components from Electro technical library. Add solenoid 
element and link name as shown in the picture 5.4. 

 

Picture 5.4. Linking solenoid Y1 with solenoid valve. 

Build complete electric circuit as shown in the picture 5.5 adding manual switch called START and run the 
simulation. Properly working circuit is presented in the picture 5.6. 
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Picture 5.5. Simulation of electro pneumatic circuit. 

If the simulation runs well, modify scheme adding proximity switch called S1. In the Variable browser add S1 
variable and link proximity switch with this name as shown in the picture 5.6. 

 

Picture 5.6. Linking of variable S1 with proximity switch 

After adding of the element and proper linking modify electric circuit adding additional relay called K1 as shown 
in the picture 5.7. 
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Picture 5.7 . Adding additional relay K1 

After inserting of solenoid coil add two additional contacts connected with K1 as shown in the picture 5.8. 

 

Picture 5.8 Adding of additional contact related to K1. 

Rebuild electric circuit and run the simulation. Final circuit during simulation in shown in the picture 5.9. 

After momentary pressing of the START button pneumatic cylinder should execute one complete stroke 
reaching proximity switch and return to its initial position. 
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Picture 5.9. One shoot electro-pneumatic circuit during simulation. 

Make following modification to presented circuit : 

• Observe circuit after proximity sensor moving away  

• Add additional limit switch, which should be active as initial condition of movement 

• Add additional pneumatic cylinders and rebuild electric circuit to build simple sequential movement of 
two cylinders 
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